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Version History
Version Description

2.3  Bug fix: checkbox to capitalize text following a 
semicolon character was broken

 Increased length of the folder/filename from 120 to 
200 characters

2.2  Ensured that illegal Windows characters are 
automatically removed from the new name prior to 
RenameTrak taking action

 Modified the renaming window to display the full 
list of illegal characters that are automatically 
removed from the new name 

2.1 Bug fix regarding the propercase conversion

2.0  Recompiled with Clarion 11.1.13815
 Fixed semicolon, underline and period checkboxes 

to display changes in realtime
 Removed the Clarion Function 1.7 library
 Added horizontal scrollbar to ABOUT window

1.9  Recompiled with Clarion 11.0.13630
 Company name changed from "Stealthware 

Software" to "Software by Daughtry"
1.8 Main window no longer auto-centered onscreen; will 

save previous session X/Y coordinates for reuse
1.7 Added checkbox to uppercase the alpha character 

following a semicolon
1.6  Bug fix: Alphabetic character following a left 

bracket symbol was not being capitalized
 Regression fix: Fixed file extension entry field not 

being disabled if a directory name was passed
 Bug fix: Can now rename an existing folder or file

1.5  Bug fix: defined the preferred application icon file 
 Bug fix: ensured that RenameTrak settings are 

saved to it’s .INI file within its application folder 
(versus the folder that RenameTrak is taking action 
within)

 Bug fix: fixed regression error which incorrectly 
changed to upper case the letter which followed an 
apostrophe symbol
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 Added a checkbox to the main Rename window 
that defines where the cursor shall be moved to 
within the Filename entry field when RenameTrak 
initializes (i.e. the start or end of the entry field)

1.4  Added a checkbox to remove a period character 
from the file/folder name

 Characters not allowed by Windows to be used in a 
file/folder name are automatically removed from 
the new file/folder name when the RENAME button 
is clicked:
< (less than)
       > (greater than)
       : (colon)
       " (double quote)
       / (forward slash)
       \ (backslash)
       | (vertical bar or pipe)
       ? (question mark)
       * (asterisk)

 The three checkbox settings are also executed when 
RenameTrak is initializing to perform the cleaning 
actions upon the passed file/folder name

1.3  Resolved bug if a folder name contained a period 
symbol.

 Added new options to remove  underline and/or 
semicolon characters via onscreen checkboxes 
(whose values are autosaved to the .INI file)

1.2  Resolved several bugs if a folder name contained a 
period (.) symbol

 Minor tweak to main renaming window to change 
text based upon file or folder being renamed

 Increased length of entry field in popup window 
from 120 to 255 characters

1.1 Fixed the propercase() function to properly change text 
that follows the “[“, “]” and “;” symbols

1.0 Initial release
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Introduction
RenameTrak is a file manager add-in utility program which adds a popup window to 
rename a file or folder via a popup window. The popup window separates the filename 
from the file extension, and the new filename’s case can be defined as lowercase, 
propercase, uppercase or left “as-is”. Characters not permitted by Windows to be used 
in directory/file names are automatically stripped from the final name to prevent 
renaming errors. 

Note: RenameTrak was developed with Clarion version 11, which still does not support 
Unicode. Non-ASCII characters cannot be handled correctly by the language – meaning 
that a folder or filename that contains Unicode formatted characters will be translated 
to a different character by the language and it can’t be renamed via RenameTrak. 

Safeguards 
RenameTrak will abandon the rename operation if either of these conditions exist:

1. A file or folder of the new name already exists in the selected folder
2. The new path+name exceeds 259 characters (because the Windows max 

preferred path length for a file or folder is 260 characters without causing 
problems)

RenameTrak Modes 
RenameTrak has two ‘modes’ of operation.  When RenameTrak is NOT passed a file or 
folder name as parameter then the main RenameTrak window is displayed onscreen, 
which permits you to access RenameTrak’s menu. If a folder name parameter IS passed 
to RenameTrak the main window is NOT displayed onscreen – the rename window is 
displayed only. After RenameTrak has the rename operation, RenameTrak is completely 
closed and control is passed back to Total Commander.

System Requirements
 Windows 8 (or higher)
 All Windows applications “like” computer memory – a starting point for any Windows 

machine should really be 16GB of memory. If this application starts running slower, 
check your Windows Task Manager for applications that are leeching memory (and then 
start closing them)

 This application runs comfortably within 10MB of disc space
 A decent color monitor capable of displaying 1024x768 (or higher resolution)
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U.S. Government Use
U.S. government agencies, to include the Department of Defense, are NOT permitted to use this 
application without written consent from the author. A per-seat usage fee will be assessed prior 
to that written authorization being granted to the requester.

How It Works
When RenameTrak is started the following actions occur: 

1. RenameTrak.ini file is opened and saved settings are loaded into memory
2. The parameter passed by the file manager is evaluated/processed to determine 

if a filename or a folder name was passed to it. If a filename was passed, the 
path, filename and file extension components of the passed string are loaded 
into variables; if a folder name was passed, the path and folder name 
components of the passed string are loaded into variables

3. The variables are preloaded into the onscreen entry fields
4. The Filename Case droplist is changed to reflect thet RenameTrak.ini saved 

value
5. The user (aka: you) enter the new name/filename into the onscreen entry fields 
6. When the RENAME button is pressed (or the Enter key is pressed, which 

automatically ‘clicks’ the RENAME button, the entered filename/folder name 
case is converted as instructed by the Filename Case droplist value; the 
individual components are pieced back together 

7. The pieced together filename/folder name is then checked for its existence in 
the current path – if it exists, a popup error window is displayed onscreen and 
RenameTrak terminates without completing the rename operation

8. If the pieced together filename/folder name length exceeds 259 total characters 
a popup error window is displayed onscreen and RenameTrak terminates 
without completing the rename operation

9. If the new filename/folder name does not exist in the current path and the total 
length is less than 259 total characters, the rename operation is completed 

10. RenameTrak closes and full control is passed back to the file manager app

Configuration
Configuration options for RenameTrak are displayed in the popup RenameTrak window. 
Confguration settings are automatically saved to the RenameTrak.ini file when 
RenameTrak closes.
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RenameTrak Screens
                          
The RenameTrak window is simple, with a standard Windows pulldown menu that can 
be executed with the mouse or keyboard: 
 

 
The main window’s menu options are purposely small, with the two important menu 
options being  
File->About and File->Exit.  

Rename Window 
If a parameter (e.g. D:\Music\) is passed to RenameTrak, the main RenameTrak window 
is bypassed and the main Rename window is displayed onscreen. The content of the 
entry fields differs if a folder name versus a filename is passed to RenameTrak:  
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Renaming a folder (Extension entry field is empty/disabled):                    

 

Renaming a file (Extension entry field is populated):

            

Three checkboxes (whose values are true if checkmarked and false if not checkmarked) 
will remove their associated special characters (a semicolon, period or an underline 
character) from the folder name or file name if checkmarked when RenameTrak 
initializes and when the RENAME button is clicked; a fourth checkbox determines where 
the cursor is placed within the Filename entry field when RenameTrak initializes. The 
checkbox values (checked/unchecked) are saved to the RenameTrak.INI file when the 
application is closed and retrieved when RenameTrak initializes. 
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The Filename case droplist has four possible values and can be changed at any 
time:

Tabs 2-4 of the RenameTrak window displays helpful information to (a) configure a Total 
Commander button to RenameTrak and (b) how to assign the F2 key to RenameTrak:
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File Manager Integration 
RenameTrak is designed to work with a file manager software application versus being a 
standalone program. Here is how to integrate it into several popular applications:

DoubleCommander

1. Right click on an empty space within the vertical toolbar; select EDIT
2. Add a new button to the toolbar; configure its settings to mimic this:

 
The important setting is the Parameter variable being passed: %p

The above screen capture shows the F2 key being assigned to the RenameTrak 
application.

FreeCommander
RenameTrak can be integrated into FreeCommander; here is a series of screen captures 
that shows how this is done: 

1. Open FreeCommander



                                           Software by Daughtry | Complexity Made Simple                            Page 11

2. Right click the mouse in the upper toolbar and select the popup menu item 
‘Customize favorite toolbars’:

3. Click the icon with a “+” symbol to add a new Favorite shortcut to the 
FreeCommander toolbar:

4. Select the new Favorite and then populate the configuration options similar to 
this:

Name: This text is displayed in the toolbar
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Program or Folder: Click the file selection button and navigate to where 
RenameTrak is installed
Start Folder: %ActiveDir%
Parameter: %ActivItem%
Icon File: Select the RenameTrak executable and select icon #3 from the droplist 
(or your favorite icon)
Hotkey: Your choice to define a hotkey; I’ve configured the F2 key to execute 
RenameTrak (which is defined as Favorite Tool 03 for my FreeCommander 
configuration)

Click OK to save the toolbar options. Don’t forget to select ‘Tools -> Save 
Settings’ from the FreeCommander main menu to save all of the options.

SpeedCommander
RenameTrak can be integrated into SpeedCommander; here is a series of screen 
captures that shows how this is done: 

1. Select EXTRAS, then USER TOOLS, then CONFIGURE from the main menu:
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2. Select NEW from the popup window:

3. Enter ‘RenameTrak’ in the popup window to name the new User Tool:

4. Select the new entry (RenameTrak) with the list of User Tools
5. Populate the entry fields for this new User Tool at the bottom of the window:

The first two entry fields will reflect where YOU have installed RenameTrak into, 
the 3rd parameter 
[  $(ActSel)  ] MUST be entered exactly like this, as this is a SpeedCommander 
internal variable name that passes the selected item from the SpeedCommander 
listbox to another application. The ‘Mode’ droplist tells SpeedCommander if the 
external application will open in Normal/Minimized/Maximized size. The two 
checkboxes can be left ‘as is’ unless you need them changed. After populating 
the information, click APPLY then OK to save the new User Tool.
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I prefer using the F2 keyboard key to rename things – to assign 
SpeedCommander to use RenameTrak when that key is pressed from within 
SpeedCommander

1. Select EXTRA, then CUSTOMIZE from the main menu; this popup window will 
appear:

2. Select the KEYBOARD tab
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3. Enter ‘DirTrak’ or ‘Trak’ (minus the quotation marks) to pinpoint the User 
Tools.RenameTrak entry

4. Enter the desired hotkey combination into the ‘Shortcuts for selected 
command:’ entry field, then click the Assign button [Note: you may need to 
remove the desired shortcut first if SpeedCommander is currently using it for 
another command]

Total Commander
RenameTrak is designed to be integrated into Total Commander (versus executed on its 
own). The parameter passed from Total Commander to RenameTrak must be the full 
path+filename of the currently highlighted file – Total Commander provides the 
required information via the combination of these two predefined parameters:

%P%N
Configuring Total Commander to use RenameTrak is simple and takes 60 seconds to 
complete. You can configure Total Commander to use RenameTrak via a button added 
to the vertical splitter bar and/or by pressing the F2 key (the Windows standardized 
keystroke to rename something) 
 

a. Add a vertical button for RenameTrak:
1. Right click the mouse on the vertical splitter bar and select ‘Change Vertical 

Button Bar’ from the popup list of items:

2. Click the ADD button and populate the button’s configuration settings similar 
to this screen capture:
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3. Click OK to save the newly added button’s settings

b. Assign the F2 hotkey for RenameTrak:
1. Click START in the Total Commander main menu
2. Select ‘Change START Menu…’ 
3. Click ‘Add Item’ in the popup window, then populate the configuration 

settings similar to this:

4. Click OK to save the configuration settings
5. Click CONFIGURATION in the Total Commander main menu
6. Select ‘Options’ 
7. Select ‘Misc.’
8. Click the button with a downarrow symbol:
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9. From the droplist of key mappings select ‘F2’:

10. The screen will now show the F2 key is assigned to the cm_UserMenu<n> 
assigned to RenameTrak:

11. Click OK to close the window
12. Click CONFIGURATION in the Total Commander main menu
13. Click SAVE SETTINGS
14. Done

Technical Information
This application requires less than 5MB of disc space for its files: 

 RenameTrak.exe – application file
 RenameTrak.Ini – configuration file (editable with Notepad or a text editor)

These files can be installed anywhere on your computer.  The currently logged on 
Windows user must have WRITE security permissions to the installation folder make 
changes to the RenameTrak.ini file. RenameTrak requires about 2.5MB of disc space, 
plus the size of the user manual (which can be deleted if space needs to be reclaimed on 
your hard drive).  

Support and Registration/Donation
1. Send us an email (scott@sdaughtry.com) that fully describes the problem(s) you’re 

experiencing and we will get back to you as soon as possible. It is prudent for you to 
fully back up this application’s folder (in full) as a precautionary pre-troubleshooting 
step.

2. This application is distributed as DONORWARE – no features have been removed or 
crippled from this application. This application’s dedicated web page located on our 

mailto:scott@sdaughtry.com
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company web site (http://www.sdaughtry.com) has a link to donate to continued 
updates of this application and/or fund the creation of other utility applications. 

http://www.sdaughtry.com
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